Computer Assignment Tips
Using MS-Excel:

Part 1:

1) Begin by clicking cell A1 and enter: t (sec), press the tab key and enter: v (m/s), and
continue this procedure until you have entered each heading. Highlight the cells in row 1
columns A through F, right click within the highlighted cells, scroll down on the menu
that appears and click on “Format Cells.” Under the “Alignment” heading click “Wrap
text” and change the “Text alignment” so as to horizontally center your text.

2) Next you will identify the given variables within the spreadsheet so they can be
“referenced.” In cells I1- L1 enter a heading for each of the four variables given in the
problem statement. Follow the same procedure in step 1 to center the headings.
Underneath each heading enter in the appropriate value (do not enter in the units here).
Your spreadsheet so far will look as shown below.
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3) Left click cell A2 and type: “0”. Press enter and type “0.1”. Now highlight these two
cells and they should both be surrounded by a thick black box with a little square in the
bottom right corner. Move your cursor over this square and the mouse pointer will
change into a black “plus sign”. Left click and drag the box until you reach cell A22.
This is the auto fill feature and if successful you will now see the numbers 0 through 2 in
increments of 0.1 under your t (sec) heading.

4) Left click cell B2 and enter the following equation as shown (no spaces):
=$L.$2+$J$2*A2 (The dollar signs make the cell references absolute. They will not
change if copied.) Press enter

5) Left click cell C2 and enter the following equation as shown (no spaces):
=$K$2-(SL$2*A2)-($J$2*((A2)"2)/2) Press enter

6) Left click cell D2 and enter the following equation as shown (no spaces):
=($1$2*(B2)"2)/2 Press enter



7) Left click cell E2 and enter the following equation as shown (no spaces):
=$1$2*$J$2*C2 Press enter

8) Left click cell F2 and enter the following equation as shown (no spaces):
=D2+E2 Press enter

9) Now that you have entered all the equations use the auto-fill procedure outlined in step
3 to carry the calculations out to row 22. Another shortcut you can use is to highlight the
first cell, and then double click the little black square at the bottom right of the
highlighted cell. This automatically fills your table.

10) Without a doubt the most important step: Check your work with a calculator!!
While this may seem ridiculous considering that Excel is supposed to be replacing the
calculator, it is necessary because Excel does exactly what you tell it to do. If you make
any mistake in your instructions to Excel it will give you an answer; the wrong answer.

11) Once satisfied with the outcome, left click and hold on cell A2 and drag the cursor to
highlight all the cells in columns A through C. Right click within the highlighted cells
and select “Format cells” from the drop down menu. Under the “Number” heading in the
window that appears, change the number type to “Number” and change the number of
decimal places shown to “2.” Use the same procedure to format the cells in columns D
through F to show 0 decimal places. Re-check your numbers to make sure they are
correctly formated.

12) Highlight the entire table by left clicking on Cell A1 and dragging the cursor to cell
F22. Right click within the highlighted table and click “Format cells.” Under the
“border” heading you will see options to set borders for your table. Click on the icons to

Mumber I Alignment I ot Elnrderl Patterns I Protection I
Presets rLine

------- i B 4 Etyle:

------- ﬂ : Mone - ——

Outline  Inside

Colar:

I Automatic 'I

The selected border style can be applied by dicking the presets, preview

diagram or the buttons above,

Part 2:

To plot the data follow the general instructions given in the following pages.

Cancel

[ o ]




How to plot data using excel

1. To begin making your plot, either single click the short-cut icon at the top of the
screen that looks like a bar graph (see figure 1) or left click “Insert,” scroll down and
select “chart.”
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Figure 1 Insert chart shortcut icon
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2. Once you click the chart icon, the chart wizard will appear. The first step of creating
a chart using this wizard is to choose the type of chart you wish to make. Generally the
best chart type to select in order to plot your data is the “XY (Scatter)” plot (shown in
Figure 2). Select XY (Scatter) in the menu on the left side and click “Next.”
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Figure 2 Chart Wizard Step 1 of 4 XY (Scatter) plot.




3. The next step of creating a chart involves telling the wizard what exactly you want to
plot. At the top of the wizard select “Series” as shown in Figure 3.
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Figure 3 Chart Wizard Step 2 of 4: Chart Source Data

4. If prior to opening the chart wizard you have selected data in your spreadsheet the
chart wizard will put together and show a preview of the plot. Do not trust the wizard to
read your mind. Figure 4 shows the layout of the “Series” section of the Chart Wizard
and some sample results. In the field to the right of “Name”, type in a name for the data
you are plotting (I have chosen “Sample Results™). The next two fields ask for the data
range for the X values and the Y values. On the far right side of each field is a square
icon with a little red arrow in the center. By left clicking this square you can tell the
wizard what data you want to use as your X and Y values respectively. In this example,
to enter in the X values, first click the little square icon to the right of the X-values field,
then left click and hold on cell A2 and drag down to select all the cells in this column
down to the last value in cell A11. Then press enter. Once you have selected both the X-
values and the Y-values click “Next.” Note: to add more than one series, simply click
“Add” shown on the left side of the window and repeat the above procedure.
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Figure 4 Select the data series to be plotted. The arrow points to the square icon used
when selecting the data points as described in step 4.

5. The next screen allows you to set the titles, axes, gridlines, legend, and data labels for
your plot. As you make alterations through this step they will be reflected in the small
preview of the plot you see on the right side of the wizard. This step should be pretty self
explanatory, but here is a run-down of what you can do. The “Title” section allows you
to assign your plot a name at the top if you have not already, and it allows you to label
the x and y axis (ALWAYS LABEL YOUR AXES). The “Axes” section allows you to
set which axes you wish to show in your plot. The default for this section shows both the
x and y axes, which is what you want so do not change this setting. The “Gridlines”
section allows you to tell the wizard to show major or minor gridlines in both the x
direction and y direction. The “Legend” section asks whether you want to show the
legend or not and where you want it to be situated in relation to your plot. The last
section is the “Data Labels” section, which if set to do so will put labels on each plotted
point. Unless there is some specific reason you wish to label each point, you should
leave this section at its default. Once you are satisfied with your plot, click “Next.”

6. The final screen of the wizard asks where you would like your plot to appear. The
wizard can either add a new sheet to your spreadsheet with a name you can prescribe in
the top most field, or it will insert the plot as an object in a particular sheet you select.
The selection you make is totally up to you and your personal preference. In the



screenshot below I selected to see my plot as a new sheet called “My Plot.” Once you
have selected a location for your plot click “Finish.” You should now see your plot in
your excel document.
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Figure 5 Final Step of Chart Wizard.

7. Are you finished? No not necessarily. What if you wish to assign a curve to your plot
or make other alterations? In the interest of brevity, I will show you only how to assign a
line to your plot. Generally, if you wish to make a specific change to the layout of your
plot, you can right click on what you wish to change and select from the menu that pops
up what you wish to alter. To put a line to your data you can right click on one of your
data points and a small menu will pop up as shown in Figure 6.
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Figure 6 Format Data Series

There are two ways you can assign a line to your plot from this menu. You can either
click “Add Trendline” which will add a mathematical trend line to your data. Depending



on what you wish to show this may be the option you should choose. Otherwise, you can
select “Format Data Series...”, which will bring up the window shown in Figure 7.
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Figure 7 Format Data Series

The first screen you see will be the “Patterns” section. On the left side you should see
“Line” with the default option “None” selected. Highlight “Automatic” and the wizard
will automatically connect all your data points with a line. Use your best engineering
judgment as to which type of line you need for the given situation, and or ask.

8. The final step, as always is to check and recheck your plot and your data to see
whether it “makes sense” and if it is in fact showing what you wanted to show.



Using MS-Word

1. a) Click on the “View” menu at the top of the MSWord program, scroll down and
click on the submenu “Header and Footer.” You should see a rectangular box in dashed
lines at the top and bottom of your document. Click inside the box and begin typing your
information. To change the left margin highlight your text and click the “Increase
Indent” button until your text is in the correct position. This can also be achieved by
sliding the triangular indent bars found above your document.

_

igert Format Tools Table Window Help Type a ques
SRV IR 0o

+ TimesMewRoman - 12 - B 1

Header and Footer
Insert AutoText -

B & M & E F O | Cose

Increase Indent button Triangular indent bars

b) To center your text or to align it left or right use the icons identified in the figure
above by the dark oval.

¢) and d) To create subscripts and superscripts first type the character you wish to make a
subscript or superscript. Highlight it and click on “Format” then the submenu “Font.”
Under the “Effects” subheading you will see options to make the text a subscript or a
superscript. Select the appropriate type of text and click “ok.” Note: Microsoft Equation
3.0 is very useful for entering equations into MSWord documents. In your free time
search Microsoft Equation 3.0 under the help menu and master this feature.



Parts e and f
How to insert a table or plot:

1. Locate the “Insert” menu in Microsoft Word
2. Left click on the Insert menu, scroll down to the submenu “Object...” and left
click it to open the Insert Object window (shown below).
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3. From the Object window select “Create from File”
4. If you know the file name, insert it in the blank field to the left of “Browse”,
otherwise left click on “Browse”, locate yout excel file and select it.
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5. By default, the “Link to file” field is not selected. When the box to the left of
“Link to file” is selected, any changes you make in the original excel file will be
reflected in the excel object in your word document. This can be a useful feature
if you have data you wish to update but for most purposes to avoid possible
human errors, this field is best left at its default.

6. Select “OK” and you will now see your excel table inserted into your word
document. Note that you can still make changes to the table if you double click
within the object.




